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The following icons are used in this user manual:

The information icon precedes important information.

& | The example icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

v | The warning icon provides a warning against potential mistakes and actions that could
~ | cause critical error.



ATTIX’

Contents
1] 0T {1 o1 o 1P 5
PrOQUCT OVEIVIEW. ...ttt ettt e e e es e e et et e e e e e e e e e e e e e 5
1. Getting Started ..o s 6
2.INStAllAtio N e e ————— 7
SYSIEM FEQUITEMENTS ...ttt aerit bt rerereeaeaaes bbbberereereeeaaaaaaaaaans 7
Installing Attix5 Pro Server Edition (SE) ........ccoooiiiiiiiiiiiiiiiiins iiiniene e e eeeeeeeeeeeinenns 9
3. ACCOUNE SELUP  woviiiiiii e es it e e e e e e e e e e eees aeeeeeeesnsnnnns 10
Setting Up @ BaCKup ACCOUNL.......ccoiiiiiiiiiiiiiiiiiiiis ettt ee s e e e e e e e e e eeeeneee eeeeeenennnn 10
Account Setup WIZard..........ooooiiiiiiiiiiiiiies e ees e 10
4. Graphical User Interface (GUI) ..o e 22
Opening the Backup Client interface............ccccvvivvviiiiiies i e e eeeeeeeeeeenns . 22
The Client interface explained.............oooiiiiiiiiiiiiiies e ees veeeeenee 23
APPIICAtION WINAOW ....ooviiiiiiiiiiiiiii s e e 23
T = 7= Vo3 (U] 1P 30
HOW 0 DACK UP ..ttty i e 30
Selecting data t0 DACK UP......cccciiiiiiiiiiiiiiiiiis it e 30
Determining the backup Selection SIZe.........ccccuvviiiiiiiiiiiiies e 38
EXporting a SeIeCtion rEPOIt ........ovvviiiiiiiii et e e 39
Starting a backup Manually .........cccooiiiiiiiiis s e 40
Scheduling automatic DACKUPS .......vvviiiiiiiiiiiiiiiis e e 41
Cancelling @ DACKUP ........uuuiiiiii s et eees aeeeeeeeeer e 43
ResuMINg @ BaCKUP.......coiiiiiiiiiciis e e ————— 44
B. RESIOIES oot e reee e 45
HOW 10 FESTONE ...t s s e et errnrnaa s e e e e e e e eeeeeennnnes . 45
Selecting data t0 FESIOME.....uuuiiiiiiiiiiiieiee et e eeeeee e 45
RESLONMNG AALA ... .euiiiiiiiiiiiiiiiiiiiiies e eeeee e e 47
Finding files iN DACKUPS........vviiiiiiiiiit i e 50
Restoring a backup SEIECHION........cciiii i e eeveeaaan 53
Restoring archived datal..........ccccviiiiiiiiiiiiis e rerreaeaaaaaens 54
1 LOgS i e e e .56
ACCESSING 10Q IlES..ciiiiiiieii i e e —————— 56
Changing 109 file SEttNGS ......uuviiiiiiiiiciiiis s e 57
8. OptionNs and SEtINGS oo e e 58
ACCOUNT AN SECUIMLY ...eeeeiiiiiiiie ettt ettt e ee e e e s aeeaeeeas 59
(0] o] 8 T=Tod 1] o 1S TP U TP TP TP 61
Backup SChedUIE............oviiiiiit e e 63
2T Yol (U o T I (o 11 = 65
D1 ] = SO 67
DISK USAQE.....iiieieiiiiiiiiiii i eee ceti e e e e e e e e e, eaaeee 69
Performance and LIMItS........ccoooiiiiiiiiiiiiiiiiis o ee ebininie e 71

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



ATTIX’

GlODAI FIIEEIS. ..ot et e e e e e es eere e e e e e e e e e e e e e e e v 73
PatChiNG ..o s e e 76
Mandatory PatChing.............uviiiiiiii e e e 79
(oo o] oo T PP P PP PP PPPPUPPR 81
AdVANCEA OPLIONS ...ciiiiiiiiiii s e eiee b aaaaaeas 83
AAVANCE TOOIS.......oii ittt bt e . 86
Concurrent backup PrOoCESSING ... .cciiiieeeiiiiiiiiiiiiies et e e e e e e e e e e eeeeeeaies eeanein 86
ReMOte MaNAGEMENT......cooiiiii it e e e rreeeeeriaaeeees 87
MuUltiple BaCKUp SetS......cccciiiiiiiiiiiiiiiiiiis ittt eereeaa e e e e 88
HEAIth ChECK.......ci i e b e e 90
Backup SNapPSNOLS.....ccooiiiiiiiciiiies i e 93
Restore Snapshots (DiSaster FECOVEIY).....cccccuuiuiiiiiiiiiiiiiiies iriiriiieeeeeeeeeeaaeaaans 94
Command-line backups and reStores...........ueeiiiiiiiiiiies e 95
PrOfilING .. s e e 97
Email NOtification PlUG-iN........uueeiiiiiiiiiits e eeeee e 99
Keyboard shortcuts and hOtKEYS ... e e 101

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



ATTIX’

Congratulations on choosing Attix5 Pro Server Edition. Attix5 Pro minimises risk, maximises
productivity and allows businesses to regain control of their most valuable asset - their data.

For technical support, pleasego to Help > About Attix5 Pro SE , and then use the contact
details provided.

With Attix5 Pro Server Edition (SE), data stored on servers and databases can bedtked up to a
Storage Platform quickly, securely and automatically.

The following diagram illustrates the scenario:

Files and folders stored on one or more

Storage Platform

servers running SE can be backed up to
a Storage Platform. In the event of data
loss or corruption on the server, you
can retrieve data from the Storage
Platform and restore it to the original
or another server in just a few easy

steps.

A Backup Administrator can manage the entire backup environment ( SE Clients and the Storage
Platform) remotely, using the Attix5 Pro Storage Platform Console. For more information,
please refer to the Attix5 Pro Storage Platform Console User Manual
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1. Getting started

Enabling manual or automatic backups is easy with Attix5 Pro SE:

BACK UP
Automaticallyor
ERE)Y

Create a Backup Select files and
ystal SE Acount folders for backup

(See page 10) (See page 30) (See pages 4042)

(See page 7)

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved. n
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Below are the systemrequirements for Attix5 Pro Server Edition.

y Note: For the latest system requirements and compatibility information, please refer to
the Requirements-Compatibility.pdf (provided with each release of the Attix5 Pro
software).

System requirements

Operating System

SEis available for the following Linux operating systems:
A Red Hat Linux
A openSuSE (ver 10.3,11.0, 11.1)
A Fedora Core Project (ver 9,10 and 11)

Processor & Memory

A Required: 1.5 GHz processor with 512 MB memory dedicated toAttix5 Pro above the
operating system requirements.

Recommendation table

Less than 200 GB Pentium 4 1GB
200 - 500 GB Pentium 4, High 1GB
50071 1TB Dual Xeon, 3 2 GB
GHz+
Disk Space

A Required :50 MB plus space for local cache.

i)

Note: Please ensure thatthe drive on which the Backup Client will be installed has
enough free space to storecopies of the selected files.

A Recommended: Amount of free space equal to the Backup Account limit if Binary
Patching is enabled. The space requirement for Delta Blocking is considerably less. For
more information, see Patching in Chapter5, A Backups. 0

L

Example : To back up 10 GB of data, at least 10 GB of available free spaceis
required on the drive containing the working folders .

Note: Plug-ins may also require additional working space. For more
information, please refer to the applicable plug -in documentation.

i)

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The local cache can be as large as the total size of all fileincluded in the backup
selection.

= A 10 GBinclusion may require up to 10 GB free space for the cache.

Minimum video requirements: 800 x 600 Resolution, 256 colours
Virtual memory: Double the amount of RAM, with a minimum of 512 MB (Total for
all disk volumes)
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This section describes how to install the SE Clienton a Red Hat Linux platform.

i Please note that you have to be logged in asroot to configure the necessary
settings.

The SERPM file contains pre-configured information to make installing SE quick and easy.

v | Pre-installationw  arning s:

If running antivirus software, p lease ensure that all Attix5 Pro folders are
excluded from being scanned to avoid data corruption.

Both antivirus software scans and backup processes are resource-intensive. It is
advised not to run a backup and virus scan at the same time as this will
significantly de crease machine performance.

Please ensure that you run the MSI file suited to the installed operating system
(i.e. 32-bit or 64-bit). The filename should indicate the target platform. If
unsure, please contact your Backup Administrator.

To install Attix5 Pro SE:

1. Copy the supplied RPM file to a local directory.
2. Execute the commandrpm 7ii aSbackup - <version>.rpm

i)

. During the installation process, the installer will verify that Java is
installed and the necessary scripts will automatically be modified with
the Java install location. The Server Edition daemon will also be
installed and started.

To verify that the Server Edition daemon is running , execute
/etc/init.d/aSbackupd status from a terminal window.

To restart or stop the daemon, use the above mentioned command but
replace status with start or stop .

3. Run the command a5backup -gui to open the Backup Client interface.
4. In the Account Setup Wizard that appears, follow the steps as describedin Chapter 3,

iAccount setup.o
i To uninstall the SE Backup Client, you need to remove all settings specified in the
setup script mentioned in the previous section. There are five commands that must be
initiated. Please ensure that you have root access when uninstalling the Backup Client .
If the GUI is open, close it and then run the following commands:
rm - f /usr/bin/aSbackup

rm - f/usr/bin/abb abackup - cli

rm - f /usr/bin/aSbackup - gui

rm - f /etc/init.d/a5backupd

rm - R /usr/share/a5backup/ to remove the aS5backup install directory

(this commend will display confirmation  prompts before every delete.)
Alternatively, use rm -Rf /usr/share/a5backup/ to remove the entire directory
in one step. Warning:  Use this command with caution.
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To backup or restore data using the Backup Client, a Backup Account is required.

You can create a new Backup Account or connect to a Backup Account that already exists on the
Storage Platform using the Account Setup Wizard.

The Account Setup Wizard appears immediately after installing the Backup Client
by default. To run the Account Setup Wizard at any other time : On the Tools menu,
click Account Setup Wizard . In the warning box that appears, click the Run
Account Setup Wizard button and follow the i nstructions below from Step 2 (below)

onwards.

The Account Setup Wizard typically consists of eight stepsto guide you through the Setup task
in a simple, step-by-step manner. These steps also make it possible to undo previousperations

by navigating backward.
Some of the settings encountered in the wizard may have been removed when the

Installation RPM was created. Furthermore, the wizard may contain additional step s.
Please read eachwindow carefully before continuing.
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Step 1 of 8: Specify Storage Platform connection settings

i) | Note : This step displays when the wizard is run directly after the SE Client installation.
If accessing the wizard at a later stage ( via the Tools menu), this step will not display as
the Storage Platform settings will already have been configured.

To specify the Storage Platform connection settings:
1. In the Storage Platform address box, type the IP address or DNS name of the
Storage Platform where the Backup Account resides
2. Inthe Group name field, specify which Backup Group the Account belongs to.
3. In the Group create key field, specify the preconfigured Group create key for the
applicable Group. If you do not have access to this key, pleasecontact your Storage
Platform administrator.

i) | Note: This key is case sensitive.
4. Once all the correct settings have been entered, lick Next .

El Account Setup Wizard x
Enter the Storage Platform connection settings. : @
Plzase cortact wour backup administrator if wvou do not have the required inforrmation. E} —
Y
Storage Platfarm Settings
Storage Platform address: 192_158_20_120 l
Group narme: A-SP OWMERA\RESELLER ANBACKUP ACCOUNTS
Group create key: ik
ATTIXPro
Help Mext >* Cancel
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Step 2 of 8: Create or connect to a Backup Account

Note s:
This wizard step is typically the first to be displayed if you access the wizard via
the Tools menu.
You can lect| want to connect to an existing Backup Account to:
Connect to an Account that has been opened for use by this computer.
Reconnect to an Account to recover data from the computer that had
previously backed up to this Account.

i

To create a new Backup Account:

1. Selectl want to create a new  Backup Account
2. Click Next .

To connect to an existing account:
1. Selectl want to connect to an existing Backup Account

/0 | warning:  Different servers cannot back up to the same Backup Account. A
separate Backup Account needs to be created for each server.

2. Click Next to continue.

El Account Setup Wizard »

Specify the account type.
Choose between a new or existing Backup Account. ¥ ou cannot connect to the same Backup Accourt from @
different machines. -y

Account Type

Flzase select ane of the following:
@ | wart to create a new Backup Accourt.

| wart to connect to an existing B ackup Account

/

ATTIX Pro

Help < Back ﬂex‘ti Cancel
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Step 3 of 8: Specify A ccount details

Depending on the option you selected in the previous step, you will either be prompted to
specify new Account details or to supply the already configured details of the existing Account.

To specify new Account details:

1. Inthe Backup Account name box, type an Account namethat consists of a minimum
of 4 characters.

2. In the Account password box, type a password that consists of a minimum of 4
characters.

3. In the Confirm password box, repeat the Account password entered in the Account
password box above.

4. In the Encryption key  box, type an encryption key that consists of a minimum of 8
characters.
L Warning : Disaster recovery is not possible without the encryption key. Please

ensure that this key is kept in a safe place. THE ENCRYPTION KEY IS NOT

STORED ON THE STORAGE PLATFORM AND CANNOT BE RECOVERED OF
RESET IF LOST.

5. Click Next .
[E] Account Setup Wizard o
Enter the new account details. -
Choose and ernter vour praferrad account name, password and encryption lkey. E& —
>

Account Details

B ackup Accourt narme: Eac kup Account 01 l

Accourt password: Fak

Minirnurn 4 characters

Confirrm passwaord: e

Plzase choose an encryption key of 8 characters or more that will be used to encrypt vour backups on
the server. Mote: If vou lose this key vou will net be able to restore your data, so write it down and
store it somewhere safe.

Encryption key: i
Minirurn & characters

Confirm kay: i

£

ATTIX’Pro

Help = Back | | Mext = | | Cancel
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When connecting to an existing Account:

1. Inthe Backup Account name box, type the Backup Account name.
2. Inthe Account password box, type the Account password.
3. Inthe Encryption key  box, type the encryption key chosen when the Backup Account

was created.

El Account Setup Wizard x

Enter the existing account details. [ 4 @

Supply the Backup Account details that wou want to reconnact to.

Account Details

Eackup Account name: | Backup Account 01 ]

Accourt password: e

Minimum 4 characters

Encryption key: U

Minirnurn & characters

ATTIX Pro

Help < Back | | Next = | | Cancel
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Step 4 of 8: Specify connection settings

To specify the connection settings:

1. In the Connection Settings area, selectl use broadband or another permanent
network connection
2. If a proxy server is to be used:
2.1. Click the Configure Proxy  button.
2.2. Inthe Proxy Setup dialog box that appears, select a proxy type.
2.3. If Use SOCKSvV5 Proxy or Use HTTP Proxy is selected, fill in the Proxy
Host and Proxy Port boxes.
2.4. If login details are required, select the Proxy server requires authentication
check box and type the username and password in theboxes provided.
2.5. Click OK to close theProxy Setup dialog box.
3. Click Next to move to the next step in the wizard.

Ey Account Setup Wizard o

What kind of connection do you have? :
Select the tyvpe of connaction that vou use to connact to the Internst. t} —
]

Connection Settings

(® [I usz broadband or ancther perrnanert network connectiori

Configure Prosxy

/

ATTIX Pro

Help < Back | | Next = | | Cancel

.3
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Step 5 of 8: Schedule backup process

Attix5 Pro can run backups on included files and folders either upon request (manually) or
automatically. This step enablesyou to set up abackup schedule.

Tip: Itis advised to back up at night when the server is running and the Backup Client
is not in use. The server must be switched on at the time(s) specified for scheduled
backups, but the Linux user doesnot needto be logged in.

To configure the Backup Client to run only manual backups:
1. Clearboth the Daily automatic backups and Advanced Schedule check boxes.
2. Click Next .

/t. | Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is
strongly advised .

Ey Account Setup Wizard o

Do you want to schedule automated backups? : @
:L >

Specify the daily and hourly backup schedule. You are strongly recommeanded to enable automatic backups.

Autornatic Backups

D aily autormnatic backups

Eack up every day at: :‘ E}}
[] Wdvanced Scheduld

Eack up at the following times

Week Day Additional Schedule
Backup time:
= €
< >
/ Warning: Mo automatic backups are specified. It is recommended to enable daily automatic backups.

ATTIX Pro

Help < Back HE#kb Cancel
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To schedule daily automatic backups

1. Select theDaily automatic backups check box

2. Inthe Back up every day at  box, specify a backup time.

3. Click Next to move to the next step in the wizard or schedule additional advanced
backups as described below and then click Next .

El Account Setup Wizard x

Do you want to schedule automated backups? [ | @

Specify the daily and hourly backap schedulz. You are strongly recarmended to enable autornatic backups.

Automstic Backups

[/] Daily automnatic backups

Eack up every day at: i‘ 19k 00 @

Advanced Schadul=
Eack up at the following times

Week Day Additional Schedule

Backup tima:

=

4

ATTIX Pro

Help < Back ﬂexib Cancel
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To schedule advanced backups:

1. Selectthe Advanced Schedule check box.

In the Week Dayarea, selecta day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule  box.
Repeat the steps above until you have added all desired schedules to theAdditional
Schedule box.

6. Click Next to move to the next step in the wizard.

a b N

[E] Account Setup Wizard x
Do you want to schedule automated backups? :
Specify the daily and hourly backup schedule. You are strongly recammended to enable automatic backups. LL_‘ —
>

Avtormistic Backups
Daily automatic backups
Eack up every day at: :‘ f:.} ¥
[/] Advanced Scheduls

Eack up at the following times

Week Day Additional S chadule
Mariday Eackup time: Monday@ 12h00
Tussday :l p\_“l Wednesday@12h00
Wednesday Sy
Thursday
Friday
Saturday
Sunday

< >

{

ATTIX Pro

Help = Back ﬂex‘ti Cancel
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Under normal circumstances, the default Temp , Cache, Logs and Database folder locations
can be accepted andyou can click Next without making any modifications. If, however, the
drive on which the Backup Client is installed has limited space available, you can move the
folders and selection databaseto another location.

/v, | Warning:  Please ensure that these folders are located on a drive with sufficient free
space.

To change the temp , cache, logs and/or database folder locations:

1. Click the Browse button next to the appropriate box (e.g. Temp ), and then select a
different location for that folder.

2. Repeat step 1 above until all folder locations are correctly specified.

3. Click Next to continue with the installation process.

" | Warning: The Cache and Temp folders must reside on the same drive/volume.

El Account Setup Wizard x
Do you want to modify the default working foldars?
“fou can move the Cache, Log, Termporary folders and the Selection D atabase to ancther location if there is @
lirmitad space available on the drive whera the Backup Cliert is installed. =

‘Waorking Folders

Mote: Always keep these folders an the sarme driveivolurme.

Ternp: Jusr/sharefaSbackup ftoBackup Browse...
Cacha: Jusr/sharefaSbackup/cache Browse...
Logs: fusr/share faSbackupflogs Browse...
Database: Jusr/share/aSbackup Browse...

ATTIX Pro

Help = Back | | Mext i Cancel
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Step 7 of 8: Specify  plug -in configuration

Attix5 Pro V6.0 installs with the Email Notification plug -in by default. In this step, you can
configure this plug-ins or accept its default configuration and proceed to the next step in the

wizard.

To configure a plug -in:
1. Inthe Configurable plug-ins list, click the plug-in name.
2. Click the Configure button.
3. Configure the settings as required. (For more information on configuration options, see
Chapter -i9ns @i.P)l ug
4. Click OK to close the dialog box and return to the wizard.
5. Click Next to continue to the next step in the wizard.

El Account Setup Wizard x
Plug-in Configuration
The following plug-ins can be canfigurad now, or vau can configura them later via the Tools @
| Plug-ins rmenu option. =

Configurable Plug-ins

Ermnail Matification w2.10

£

ATTIX Pro

Help = Back | | Mext ; Cancel
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In the final step of the Account Setup Wizard, a Summary screen displays a list of the configured
settings.

To confirm the Setup information:

1.

Read and verify that the information is correct, and then click Next .
2.

The Backup Client will connect to the Storage Platform and configure the Backup

Account. A message will be displayed to confirm that the Account was set up
successfully.

3. Click OK to close the message box.

Ey Account Setup Wizard x
Confirm your account settings. @
If the settings below are correct then click Mext, atherwise click Back to change vour settings. LE —
Summary
You have entered the following inforrmation:
AttixS Pro SE Username: Backup Account 01
C onnection methad: Local Area Hetwork
Automatic backups:
Monday: 12ho0
Wednesday: 12ho0
ATTIX  Pro
Help < Back | | Next i Cancel

Now that a Backup Account has been configured/you have connected to an Account on the
Storage Platform, you can select the files and folders you wish to back up.
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You can use the Graphical User Interface (GUI) to:

Select files for backup

Launch backups

Schedule automatic backups

Find files in previous backups

Restore files and folders from previous backups

To open the SE Client interfa  ce:

1. Log on as the root user.
2. Run the command a5backup -gui to open the Backup Client interface.

The first time you open the Backup Client, the Account Setup Wizard launches
automatically . For more information on creating a Backup Account,seeChapt er 3,
setup. o
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The Client interface explained

You can manage and monitor backups using the Backup Client application window. Below are
descriptions of each of these items and the options they provide.

Application window

The Backup Client application window contains the following areas:

E Attix5 Pro SE V6.0.0 —Ox
Flle sSelection Tools Help <} Menu bal’
) f-' @ y, @ & Product Help
mowp  She | Resmre  Fing | Optons Auomze || Heln ATTIX Pro Toolbar
[gackup Selection @ IBesmre @ | Legs £ _
> @ My Computer [ | Filename [ Size | Date [ | — Tabs
b dbus [ .dbus 2009-07-2.. | 2| | quicke-stant 1
b l,‘ Eackups Right click for selection optiond 2009-11-3... Step-by-step quide
= bi L on 2009-07-2...
b t bt = boot 2009-07-2... | — Product Help
b L= dev = dev 2010-01-2... T Use selection fiters. ol
b ete o etc Export a selection repart /
- - Backup manually
P = home 'L'f R;)me 2005079 Schedule automatic backups / Status bar
P lib — i e
L= lost+found | | L= lost+found 2009-07-2... Restores: How to... el
= media L= media 2009-07-2... Restore files and folders
SR S 2005050 | || Eedmalciactrie s
L= opt = opt 2009-03-0...
b L= proc L= proc 2009-11-1...
b = root L= root 2010-01-2...
1= sbin = sbin 2009-07-2...
b= selinux = selinux 2008-11-1.._~"| Backup throttie
£ srv & s 2009- Display
b sys & e Disk usage
b L tmp - 5y Performance and limits
b I.)‘ st = tmp 2010-01-2... Llobal filters
- L usr 2009-07-2... Patching
b= var & var 5009-07-2 Mandatery patching
- 0720 Loaaing
© autofsck 0KB 2009-11-1... Advanced options
©  readahead_collect 0KB 2010-01-1.. o )
& 1KB 2010-01-1.. ,;ddmunal information
esuming backups
O 16KB 2010-01-2... Notifications
O 100KB 2010-01-2... Server Edition auto-updatas
o~Tackupservice log.2 100KB 2010-01-1.. W%ﬁw
Adding network volumes
[ © backupsetxml 1KB 2009-10-1. || | himote tiammmement
— A bulsile Backup Sets ©

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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toolbar buttons

All Backup Client functions can be performed from the menu bar. Shortcuts to the most
commonly used menu bar functions are also available on the toolbar and right -click menus.

Menu bar

Each menu on the menu bar contains one or more options. The tables below describethe

options available.

File menu

Backup Now

Restore

Calculate Size

Find Files in
Backups

Export

Selection

Exit

Initiate a Backup immediately.

Switch to the Restore view in the Client.

\;) Tip: For faster access to the Restore view, click the Restore tab
instead of using the File menu.

Determine the total size of the data included in the backup selection. For more
information, see Determining the backup selectionsizei n Chapter 5,

Access theFind Files in Backups  dialog box. This box enables you to search for
particular files in your backups. For more information, see Finding files in
backups in Chapter 6, fARestores. o

Export a list of all backup inclusions and exclusions to an html file for future
reference. For more information, see Exporting a selection report in Chapter 5,

fBackups. o

Close theBackup Client application window.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Selection menu

Filters > New Filter Create a new filter to automate inclusions or exclusions based on file
type. For more information, see Using filters in Chapter 5,
AfBackups. o

Filters > Edit Filters Edit existing filters. For more information, seeUsing filters in
Chapter 5, fABackups. o

Filters > [ filter ]> Include I nclude all files in the selecte
For more information, seeUsingfiltersi n Chapter 5,

Filters > [ filter ] > Exclude Excludeal | files in the selected fo
For more information, seeUsingfiltersi n Chapter 5,

Filters > [ filter ] > Deselect Clear the selected folder of any filters currently applied to it. For
more information, seeUsingfilters i n Chapter 5, AB
Include Folder Include the selected folder for backup.
Exclude Folder Exclude the selected folder from the backup selection.
Deselect Folder Clear the selected folder of any inclusions or exclusions.
Refresh Refresh the selection being displayed.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Tools menu

Additional Backup
Sets > Add

Additional Backup

Sets > Manage

Automatic Backups

Account Setup Wizard

Remote Management

Health Check

Snapshot > Export
Backup Snapshot

Create additional backup sets. This enablesyou to have separate backup
selections that you can recoveras separate sets of files.For more
information, see Multiple Backup Sets in Chapter 8, Ogtions and
Settings. 0

Access the Backup Schedulgagein the Options and Settings  dialog
box. Using the settings in this dialog box, you can manage the schedule(s)
of your backup sets. For more information, see Multiple Backup Sets in
Chapter 8, Options and Settings. 0

Access the Backup Schedule settings in théptions and Settings  dialog
box. Configure the settings in the Automatic Backups area to set up one or
more automatic backups. For more information, see Scheduling

automatic backupsi n Chapter 5, fiBackups. o

Launch the Account Setup Wizard, which enables you to change the
Backup Account settings. For more information, see Account Setup
WizardinChapter 3, fAAccount setup. o

Access theRemote Management Settings dialog box. Using the
settings available, you can enableRemote Management of the Client via

the SP Console. For more information, seeRemote Management in
Chapter 8, fAOptions and Settings. o0

Access theHealth Check dialog box. Performing a Health Check enables
you to highlight possible issues. For more information, see Health Check
in Chapter 8, fAOptions and Setting

Accessthe Export Backup Snapshot dialog box, which enables you to
configure the next backup to be a Snapshot backupto a specific location.
For more information, see Backup Snapshotsi n Chapter 8,
Settings. o

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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7ools menu continued...

Click the option to...

Snapshot > Import
Restore Snapshot

Plug -ins > Email
Notification

Options

Help menu

Accessthe Import  Backup Snapshot dialog box, which enables you to
configure Restore Snapshot settings For more information, see Restore
Snapshotsi n Chapter 8, AOptions and Set

Access theEmail Notification settings dialog box, which you can use to
enable/disable email notification and configure the plug-i n etsings. For
more information, see Email Notification plug-ini n Chapt eirn 9.

Opens theOptions and  Settings dialog box that enables you to modify a
range of Client settings. For more
Settings. o

Click the option to...

Icon Legend

Product Help

About Attix5 Pro  SE

Access a list of the icons used in the Attix5Pro Client and their meanings.

Access the Product Help.

Access the product information and support contact details.
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Tabs

There are three tabs availablein the Backup Client:
This tab displays the files and folders on the computer, enabling
you to select the items to be backed up For more information , see Selecting data to

Backup Selection:

backupi n
Restore:

Chapter 5,

ATTIX’

iBackups. 0
Use this tab to browse previous backups and restore files and folders.

Logs: Use thistab to view detailed information on each backup and restore.

Tip: In the right -hand pane on the Backup Selection
any of the column headings to sort the list according to their values.

and Restore tabs, you can click

[Eackup Selection & l Restore 4| Logs =|

= @ My Computer

Lo .dbus

P L= Backups
L= bin

P L boot

P dev

P L ete

Lo home

P lib

I~ lost+found

L= media
L= mnt
L~ opt

P L= proc

P L root
L= sbin

P Lo selinux
L= sy

P L= sys

P L= tmp

P L usr

P L= var

| Filename Size
I~ .dbus
L= Backups
L= bin
L= boot
= dev
= etc
L= home
= ik
I~ lost+found
L= media
L= mnt
L= opt
L= proc
= root
L= shin
L= selinux
L= sry
L= sys
L= tmp
L= usr
L= wvar
) Lautofsck 0 KB
T readahead collect 0 KB
T aSbackup.log 1KBE
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@ You can acess theBackup Client Help by clicking Product Help  on the Help menu.

| Alternatively, click the Help button on the toolbar.
Help

As you navigate the Client, the Help pane will display information relevant to the selectedtab.

This area displays the date and time of the last backup performed by the system.

Ready Last backup:lan 28, 2010 1:47:39 AM

v | Warning:  The Backup Service must be running at all times for backups (manual or
scheduled) totake place.
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After installing Attix5 Pro Server Edition (SE) and creating a Backup Account,you can tell the

Backup Client which files and/or folders to back up and which to ignore by creating a backup

selection ( see A Sel dgockadkom @ 0 d & eYow ean then start a backup manually or

schedule automatic backups ( see HfAPer f or miakmkuao mandaliSbhedul ing a
backupsodo bel ow) .

i Any changes, additions or deletions to included files and folders will be backed up
intelligently with every manual or scheduled backup.

The following sections describe how to:

Selectdata to back up

Use Global Filters to specify files and/or folders to be excluded from the backup
selection.

Determine the backup selection size

Start backups (automatically and manually)

Cancel a backup

Resume a failedor cancelled backup

You can make your first backup selection or modify a backup selection at any time usirg the
Backup Selection tab as described below.

To select files and folders for backup:

1. Click the Backup Selection tab.

2. In the Backup Selection tree, navigate to the folder or directory containing the file or
folder.

3. Include or exclude files and/or folders, as described below.

Once a file or folder is included in the backup selection, any modifications to it will

w | be backed up automatically. For mor e i nformation, see Pa
and settings. 0
v | Warning:  If you have limited space on the drive running the Backup Client, it is

recommended that you move the Cache , Logs and Temporary folders as well as the
selection database to another location. For more information, see Disk Usage in
Chapter 8, ®dOptiogs. and
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To include an individual file:

In the right -hand pane, click the file icon ' or right -click the file name, and then click Include .
An included file is displayed with a green icon: ©

To deselect a file, you can either click the icon againor right -click the file name, and then
click Deselect . A folder containing some included files is displayed with a green tinted icon:
&

To include an entire folder:

Right-click the folder icon -, and then click Include Folder . Alternatively, you can select the
folder in the Backup Selection tree, and then click Include Folder on the Selection menu.
Included folders are displayed with a green icon: £,

All files in the included folder and its subfolders will be included in the next
backup. Any changes made within this folder or its subfolders will automatically be
included as well.

To deselect a folder,right -click the folder icon, and then click Deselect Folder

To exclude a file or subfolder:

If an entire folder is included but you wish to exclude a particular file or subfolder, right -click
the file or folder icon,and then click Exclude or Exclude Folder . Excluded items are
displayed with red icons: & or ¥ Included folders that have some files or subfolders excluded
are green with a red tint: £

You can create different backup selections for different backup sets. For more
information, see Multiple Backup Setsi n Chapter 8, AiOpti o
You can usefilters to automate file selection based on file types. Once you have
selected all files to be included and excluded, it may be useful to check the size of
your backup selection before initiating your first backup. For more information,
see Using filters later in this chapter.

i) Some directories (and their contents) are forcefully excluded from the backup
" | selection. OnMac machines, these are the/dev and /proc directories.
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You can use filters to automate file inclusions or exclusions within a folder, based on file types.

=

A *.txt filter will include or exclude all text files within a folder, as well as

any new text documents that are added to that folder later.

To apply a predefined filter to a specific folder:

1.

2.
3.
4

In the Backup Selection tree, right -click the folder icon.

Point to Filters .

Point to one of the available filters in the list (e.g. Graphics ).
Click Include or Exclude .

To modify an existing filter:

1.

To add a new filter from within the Edit filters
a name that describes the filter, enter the file type(s), and then click OK.

In the Backup Selection tree,right-click the folder icon, point to Filters , and then

click Edit filters

Select one of the filters andthen modify its properties in the Edit filter

Click OK.

To add a new filter via the Backup Selection tree:

1.

2.
3.
4

Right-click the folder icon, and then click New filter

In the Filter name  box, type a name to be used in the Filters menu.
In the Filter box, specify the file extensionsto which the filter wil | apply.

Click OK.

dialog box, click the New button, supply

The filter will be added to the Filters menu and you will be able to use it to include or exclude all
files matching its criteria.

To remove filters from a folder:

1.

2.
3.
4

Right-click the folder icon.

Point to Filters .

Point to the name of the filter you wish to remove.

Clear the check mark next to the selection (nclude or Exclude ).

To identify files and folders selected by filters:

Look at the icon state. Files and folders included in the backup selection by filters display with
icons containing blue check marks: & and v
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Some inclusions and exclusions are enforced at administration level on the Storage Platform.
This is c¢al | Fodmorepnfoonfatiod, see gPéofiing i n Chapter 8d AOption
Settings. 0

Files and folders affected by profiling display with the following icons :

File inclusion
¥ Filtered file inclusion
File exclusion

Folder inclusion

o Filtered folder inclusion
(x] Folder exclusion
i) Profiled selections cannot be modified from within the Backup Client and can o nly be

changed on the Storage Platform. For more information, please refer to the Attix5 Pro Storage
Platform Console User Manual .

Global filters enable you to specify files and/or folders to be excluded from the backup selection.
They also enable you to specify which file typesshould not be compressed before backup.

To add Global Filters:

1. Click the Options button on the toolbar, and then click Global Filters
2. Select the type(s) of filters to apply and then specify their values.(For more information,

seeGlobal Filtersi n Chapter 8, fAOptions and Settings. 0)
3. Click OK.



ATTIX’

Icon legend

On the Backup Selection tab, each file and folder is displayed with an associated icon The
colour of the icon indicat es status.€¢Forfmork ieformatonbro | der 6 s b
backup selections,s e 8efiect i ng d adarierihtbisdhaptery up o

Backup Selection & ‘ Restore 4l | Logs =] |
< @ My Computer Filename /
b & .dbus & dbus
' bin L: bin
b £ boot (# boot
b L= dev L7 dev
L etc L: etc
b £ home = home
b £ lib @ lib
L= lost+found L= lost+found
L= media L= media
L= it k= _mnt

The following icon legend lists the Attix5 Pro icons and the statuses they indicate. You can
access this legend byclicking Icon Legend on the Help menu.

Icon legend

O File (not selected) The file exists in the folder or directory but is not included in
the backup selection (neither included nor excluded).

[ = Selected by user The Backup Client user hasincluded the file in the backup
selection.

e Selected by user filter The Backup Client user has applied a filter to the parent folder
or directory. That filter has included the file in the backup
selection.

[=] Excluded by user The Backup Client user hasexcluded the file from being

backed up to the Storage Platform.

[ %] Excluded by administrator The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Included by profiling

Included by profiling filter

Excluded by profiling

Folder (not selected)

Some files selected by user

All files selected by user

All files selected by user,
some excluded

All files excluded by the
user

Filter applied by user

Filter applied by user,
some excluded

All files included by
profiling

Filter applied by profiling

The Backup or Storage Platform Administrator has included
this file or file type. Files displaying this icon will be backed up
to the Storage Platform and cannot be deselected from within
the Backup Client.

The Backup or Storage Platform Administrator has applied a
filter to the parent folder or directory. That filter has included
the file in the backup selection. Files displaying this icon
cannot be deselectedor excluded from within the Backup
Client.

The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform and cannot beincluded in
the backup selectionfrom within the Backup Client.

The folder exists in the directory but it is not included in the
backup selection.

The Backup Client user hasincluded some filesin the backup
selection.

The Backup Client user hasincluded all files in the backup
selection.

The folder contains no unselected files. Each file is either
included or excluded.

The Backup Client user hasexcluded all files in the folder from
being backed up to the Storage Platform.

The Backup Client user has applied a filter to the folder. The
filter has included one or more files within the folder.

The Backup Client user has applied a filter to the folder that
hasincluded and excludedfiles within it.

The Backup Administrator has included all the files contained
in the folder. All files will be backed up to the Storage
Platform. These inclusions cannot be changed by the Backup
Client user.

The Backup Administrator has applied a filter to the folder.
This filter cannot be removed by a Backup Client user.



Tx)

Filter applied by
profiling , all items
excluded

Filter applied by
profiling, some items
included by user

Filter applied by
profiling, some items
included and some items
excluded by user.

Filter applied by profiling
but items excluded by

user.

Folder excluded by
Global Filter.

All files excluded by
profiling

Plug-in node (not
selected)

Some items selected by
user

All items selected by user

All items selected by user,
some excluded

All items excluded by
user

Filter applied by user

ATTIX’

The Backup Administrator has applied a filter to the folder ,
resulting in the folder being excluded from the backup selection.
This filter cannot be removed by a Backup Client user.

The Backup Administrator has applied a filter to this folder

using profiling and some items have been manually included by
the Backup Client user (see 0ff¢
this chapter).

The Backup Administrator has applied a filter to this folder
using profiling. Some items have beenexcluded and others
includedby the Backup Client wuser
upo earlier in this chapter).

Items in the folder have beenincluded using filters (seefUsing
filters6 earl i er in this chapter.)

The folder has beenexcluded using Global Filters. For more
information, see Global Filtersi n Chapt er 8, i C
settings. 0

The Backup Administrator has excludedall files in the folder.
Theseexcluded files cannot be included by a Backup Client user.

The plug-in exists but is not selected for backup to the Storage
Platform.

The Backup Client user has selected some of the items in the
plug-in for backup to the Storage Platform.

The Backup Client user has selectedill items in the plug-in for
backup to the Storage Platform.

The Backup Client user hasincluded and excluded items in the
plug-in.
The Backup Client user hasexcluded all items in the plug-in

from being backed up to the Storage Platform.

The Backup Client user has applied a filter to the plug-in;
specifying that certain file types must be included for backup to
the Storage Platform.
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lcon legend menu continued...

ﬁ' Filter applied by user, The Backup Client user has applied a filter to the plug-in;
some excluded specifying that certain file types be included for backup to the
Storage Platform but some items have beenexcluded either

through the use of an exclusion filter or by manual exclusion.

q) Note: For more information, see Profiled selectionsi n Chapter 4, nGrap
(GUNDO and-inPmhGlgapter -9ns .A®l ug

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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It is useful to determine the backup selection size beforestarting the backup process to avoid
Over Limit errors.

The Backup Client compares your backup selection size with the Backup Account
limit (specified by your Backup Administrator) at the beginning of the backup process. If
the selection size exceeds the Account limit, the backup process will stop and anOver

Limit error message will be displayed.

To calculate the backup selection size:

A. On the File menu, click Calculate Size.
B. Alternatively, click the Size button on the toolbar:

2600 @0 @

Backup Size Restars Find Options  Autornate . Help

The Backup Selection  Size dialog box that appears displays total size of your backup

selection (i.e. all files included for backup).

Backup set index prepared in 1s
Files and directories: 3036 Total size: 78.17 MB

Mandatory files: 0 Total size: 0 bytes

/v, | Warning:  If your backup selection size exceeds your Account limit, you need to remove
some items from the selection or ask your Backup Administrator to upgrade your

Account limit.

To remove a file from the backup selection:

A. In the Size dialog box, right-c | i ¢ k

that it is excluded: &.
To exclude multiple files at once, click a file name in the list, hold down the
Shift key and drag the mouse pointer to highlight the files. Right -click the

selection, and then click Exclude .

t h e ©fThd icod will turnc kechto indicate

B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are

currently selected for backup. For more information, see Selecting data to back up in

Chapter 5, ABackups. o
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Exporting a selection report

After creating a backup selection, you can export a list of all backup inclusions and exclusions to
an html file for future reference.

The selection report will specify:
Files and folders included in the backup
Files and folders excluded from the backup
How each item was selected (userselected, filters, profiling or mandatory patching)
Where each item is located on the machine
The total number of items in the backup selection

To export a selection report:

1. Onthe File menu, click Export Selection
2. In the Save As dialog box, select the location in which to save the file, type a file name
in the Selection box, and then click Export .

The file will be saved to the specified location and can be viewed in any Internet browser.

|@ file://fhome/at...Selection.html | aF v
ASBP Backup Set as on30.Jan 2010 06:54 PM
Backup Account: Account 01
Backup Group: A-5F OWNER'\RESELLER ABACKUP ACCOUNTS
Storage Platform: 192.168.20.120
Backup Set Name: Default
Backup Set Version: 5.0
Client Version: 5.0.0708
Schedule

Daily backups for this backup set occur at 19n00

Mo advanced schedule is defined.

Selections

Overview
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Starting a backup manually

) | Tip: It is recommended that you run a backup manually after creating your backup selection

to ensure immediate data transmission to the Storage Platform . Thereafter, automatic backups
will ensure hassle-free continuous backups. For more informat i o n, see fASche
b a ¢ k Uapesimthis chapter .

To starta backup manually :
1. Onthe File menu, click Backup Now . Alternatively, click the Backup button on the
toolbar.

O

Backup

The Backup dialog box appears and displays the progress of the backup:

o Backwp
G piESSiRD ond patching

Connecting to service

Starting backup

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.120:443

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue
will display in the Backup dialog box, enabling you to cancel the current backup in
favour of the next, should you wish to do so.

L Adding a5backup-6.0.0-257.x86_64.rpm

Queued backups:
db

For more information, see Multiple Backup Setsin Chapter 8, Opiions and Settings. 0

2. To close the Backup Qient after the backup process has started, click theHide button.
This will not cancel the backup process and the Backup Client can be r®pened at any

time to view the progress of the backup.

‘u} Tip : To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Automatic backups are usually enabled and configured during the Account Setup process (see
Step 5 of 8: Schedule Backup Processin Chapter 3 , iAccount yoSeah enpblepnd b u t
schedule them at any point in time using the Options and Settings  dialog box.

To schedule da ily automatic backups

1. On the Tools menu, click Options . Alternatively, click the Options button on the
toolbar.

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selected in the
Backup Set drop-down box. (For more information on backup sets, see Multiple
Backup Setsin Chapter 8, Opgtions and Settings. )0

4. Select the Daily Automatic Backups check box and then specify a badkup time in
the Back up every day at  box.

5. Click OK.

To schedule advanced backups:

1. Onthe Tools menu, click Options .

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selected in the
Backup Set drop-down box. (For more information on backup sets, see Multiple
Backup Setsi n Chapter 8, AOptions and Settings. 0)
Select theAdvanced Schedule  check box.

In the Week Day box, selecta day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule box.

Repeat steps5 to 7 above until you have added all desired schedules to theAdditional
Schedule box.

© N o oA

You are advised to back up at night when the server running the Backup Client is
not in use. It must be switched on at the scheduled backuptime(s), but the Linux
user does not need to be logged in.

Configuring automatic backups ensures that all selected data is backed up
automatically, without the need for any user interaction. This is a safer
alternative to relying on manual backups.
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Backups will initiate at the scheduled times and the Backup dialog box will appear displaying
the progress of the backup

s Backup B
I GoBRERSiRG: on petching

Connecting 1o service

Starting backup

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.120:443

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue will
display in the Backup dialog box, enabling you to cancelthe current backup in favour of the
next, should you wish to do so.

L Adding asbackup-6.0.0-257.x86_64.rpm

Queued backups:

db
For more informatio n, seeMultiple Backup Setsi n Chapter 8, AiOptions and Set
Tips:

To close the Backup Client after the backup process has started, click theHide button.
This will not cancel the backup process andyou can re-open the Backup Client at any
time to view the backup progress.

To view backup logs, dick the Logs tab. Backup log dates are displayed in blue.

Backup Selection @ Restore 4 | Logs =

clgE Rl E= Rl ~[Message: 19:03:22
30 Jan 2010, 19:00:02 Message: 15:03:22
28Jan 2010, 01:47:37 || [Message: 15:03:22
28]an 2010, 01:44:24 | [Message: 19:03:22

B I T . T B s |

J
J
J
J

Backups will be stored on the Storage Platform and accessible via theRestore tab. For more
information on restoring data, see Chapter 6, fiRest ores. 0

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Cancelling a backup

Once a backup is in progress, you can cancel the process via the Backup progress window.

To cancel a backup:

In the Backup progress window, click the Cancel button.
s  Backup [
Starting backup

Connecting 1o service

Starting backup

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.175:443

Connecting to Storage Platforrm on 192.168.20.175:442

CEECEl Hide

The backup will be cancelled
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Resuming a backup

By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. If, however, the previous backup was not successfuland a
manual backup is initiated, the Backup Client will display the prompt: Do you want to

resume the failed backup ... 20with a 30 second countdown.
El Confirm resume b ckup »

Do you want to resume the failed backup from Sat 30 [an 2010, 19:50:597
(A new backup will start in 20 seconds)
Q@srce] | @

Click Yes to instruct the Backup Client to try to continue from where the process fail ed during
the previous backup. Click No to initiate a new backup or Cancel to return to the Backup Client
application window.

iy,r- Note: A new backup will be initiated automatically after the countdown has elapsed.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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On the Restore tab, you can browse a tree structure representation of all successful backups
and their files and folders.

The following sections describe how to select data to restore, start the restore process, and
search for specific backed up files.

On the Restore tab, the Restore tree gives you accessa backed up files via two main nodes:
Last Backup and Previous Backups

Backup Selection @ | Restore @ | Logs = The Last Backup node contains
= = = the file/folder structure of the last
Vv I,__B.aLcasLépBSackup (30 jan 2010, 19:51:28) | successful ballckup.and displays the
=l date and time it occurred in
s Workspace parenthesesfi (. ) 0
L= boot
P I*jome i) Restores done from
B b | the Last Backup node are
b root typically faster than those
| = L= Previous Backups | done from the Previous
L2 01 Feb 2010, 10:15:23 Backups node as the
P L= 01 Feb 2010, 09:27:51 Backup Client may be able to
P L= 01 Feb 2010, 09:26:39 retrieve the data from the
P L= 29Jan 2010, 16:12:07 cache instead the Storage
Platform.

When you expand the Previous Backups node, the Backup Client retrieves the list of previous
backups from the Storage Platform and displays them in the tree.

To select and restore data  from the

1. Click the Restore tab.

2. Expand the Last Backup node to view the files/folders.

3. Include a single file by clicking the ' icon next to the file or by right-clicking the file
name and then clicking Include . Eachincluded file is displayed with a green icon: ©.
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4. Include an entire folder by right-clicking the folder icon and then clicking Include
folder . Eachincluded folder is displayed with a green folder icon: L=
5. If an entire folder is included but you wish to exclude a particular file or
subfolder, right -click the file or folder icon, and then click Exclude or Exclude
Folder . Excluded items are displayed with red icons: & or £¥. Included folders that
have some files or subfolders excluded are green with a red tint: £
6. Once all the files and folders to be restored are selectedstart the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on the restore options available, seefiRestoringdatad | at er i n this cha

To select and restore data from

1. Click the Restore tab.

2. Expand the Previous Backups node to connect to the Storage Platform and retrieve a
list of all previous backup dates.

3. Expand the relevant backup node, and then click the folder or directory containing the
data.

4. Include a single file by clicking the T icon next to the file or by right-clicking the file
name and then clicking Include . Each included file is displayed with a green icon:

5. Include an entire folder by right-clicking the folder and then clicking Include . Each
included folder is displayed with a green folder icon: £='.

6. If an entire folder is included but you wish to exclude a particular file or
subfolder, right -click the file or folder icon, and then click Exclude or Exclude
Folder . Excluded items are displayed with red icons: & or £ Included folders that
have some files orsubfolders excluded are green with a red tint; =

7. Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on the restore options availab | e , Resteriag détadbelow.
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After you have selected the files and folders to restore, you canstart the restore process as

described below.

To start the restore process:
1. On the File menu, click Restore . Alternatively, click the Restore button on the

toolbar:
AN OO
Backup Size Restore Find Options  Autornate  Help

The Restore dialog box will prompt you for a restore location:

Save files in:
O Original location

® Folder: | /root/Restore Browse

2. SelectOriginal location  to restore the files to the same location that they were backed
up from or selectFolder and then browse to a new location.

/v | Warning:  If Original location is selected the restored files will overwrite
any existing files with the same name in that location. A warning will, however,
be displayed before the Backup Client overwrites any files.

In the Options area, specify the restore options.

Options
< Recreate directory structure
+ Restore empty folders
Owverwrite files
Use compression (faster over the Internet)

< Restore file and folder permissions
Restore directly to target location (faster, but resume on file level not possible)

For more information on restore options, please refer to thei Rest ore optionsao

below.

3. Click OK.

t
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Restore options

Recreate directory

structure

Restore empty folders

Overwrite files

Use compression

Restore file and folder

permissions

By default, the folder structure is recreated in the Restore folder. To
specify that all files be restored to one location, clear the Recreate
folder structure  check box

i) | Note: If restoring files from different folders with the
same file names, you need to recreate thedirectory
structure to prevent overwriti ng the files.

To restore all empty folders within the directory structure, select the
Restore empty folders  check box Clear the check box to restore only
those folders containing backed up files.

1/ Note: This option is only available when Recreate
directory structure is selected.

Selectthis option to prevent the Backup Client displaying a prompt before
overwriting existing file s.

-y
A AN
H

/vy | Warning:  If this check box is selected, files with matching

filenames in matching directories will be overwritten without
warning.

Select theUse compression check boxto enable the Storage Platformto
compress files beforetransmitting them to the Backup Client.

\J Tip: You are advised to enable this setting when
restoring over a slow Internet connection as it will
reduce the size of the files, making the transfer
process faster.

Clear this checkbox to prevent the Backup Client restoring file and folder
permissions. You would typically only select this option after a complete
server failure (to restore files before user accounts are recreated).
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Restore options continued...

m

Restore directly to Select this check box to write files directly to the specified folder without
target location using a temporary working folder. The restore process is faster using this

option due to less disk access. Howevera file-level restore resume is not
possible. Should there be a communication error during a file transfer, the

complete file will be resent.

y Note: You can view restore logs on the Logs tab. Restore log dates are displayed in
green.

26 Jan 2010, 15:25:22
25 ]an 2010, 15:25:08
A lAN 2010, .07:44:24

MMoccama.
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To find a specific backed up file, it may be easier to use theFind function than to browse the
Restore tree.

You have the option to scan only your last backup (locally), or you can connect to the Storage
Platform and search through previous backups.

To search for afilein  your latest backup:

1. On the File menu, click Find Files in Backups . Alternatively, click the Find button
on the toolbar:

L1990 @ e @

Backup Size Restars Find Options  Autornate . Help

2. Type the file name or part thereof in the File name box, and then click Find .

File name (full or partial): |sales
® Search last backup (local)

search through previous backups (Storage Platform)

& Limit number of results to: |10

x If fsalesdis searched for, the Backup Client will display a list of all files in the
| ast backupsaedsnti ai hhegfil ename.

Use the* and ? wildcards for advanced search queries.
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To search for a file in previous backups:

1. On the File menu, click Find F iles in Backups . Alternatively, click the Find button
on the toolbar:

Y1990 @0 &

Backup Size Restare Find Options  Autornate . Help

2. Type the file name or part thereof in the File name box.

3. Select theSearch through previous backup s (Storage Platform)  check box.

4. If you wish to limit the search to particular dates, select the Search backup dates
check boxand then use the Start date and End date boxes to specify a time period.

5. To limit the number of results that display, select the Limit number of results to
check box and thentype a number in the box provided.

6. Click Find .

File name (full or partial): |sales
Search last backup (local)

* Search through previous backups (Storage Platform)

< Search backup dates

Start date: [01-28-2010 | v | MM-dd-YYYY

End date: |01-31-2010 || + | MM-dd-YYYY

<1 Limit number of results to: |10
Find
Use the* and ? wildcards for advanced search queries.

i) If Search backup dates is selected the backup date is used for the search
instead of the file create or file modified date.
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To restore files from the Find Files in Backup dialog box:

1. Inthe search results list, include the files to restore by clicking the icons next to the file
names or by right-clicking each file name and then clicking Include .
2. Click the Restore button.

File name (full or partial): [sales

® Search last backup (local)

Search through previous backups (Storage Platform)

Limit number of results to:

Find
Search result
.| Folder |Filename |.. |Date |F.. [Bac.. |
) /homefatti... salesCl OKB 31/01... 31/01...
T /homefatt... sales02 OKB 31/01... 31/01...
Restore

The Restore Options  dialog box will appear, enabling you to specify the location in which to save
the restored files. For more information on restore
this chapter.

C
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Restoring a backup selection

By default, with every backup performed, a copy of the backup selectionis saved on the Storage
Platform. For more information on backup selection, see fiSelecting data to back up earlier in

this chapter.

This enables you to restore, not only your backed up filesand folders, but the selection you used
to back them up as well.

i) | Note: This is especially useful in disaster recovery cases, as it enables you to restore
your entire backup setup to perform exactly as it did at the last backup.

To restore a backup  selection:

1. Click the Restore tab.
2. Expand the relevant backup folder, and then click the Workspace node.

Backup Selection al Restore i

- @ Backups
< | Last Backup (31 Jan 2010, C
-

I~ boot

3. Inthe right -hand pane, click the icon next to the name of the backupset toinclude it for
restore. If you have not enabled Multiple Backup Sets (see Multiple Backup Sets in
Chapter 8, AOptions and Sethatdisplays o), i nclude the

Filename
® backupsetxm

2 Include

& Exclude
T Deselect

4. Click the Restore button on the toolbar.
5. Select the appropriate restore options. ( See fASelecting data to resto

chapter.)
6. Click OK.

The backup selection will be restored to the location specified in the restore options.
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Atti x5 Pro allows Backup Administrators to archive
drive using the Hierarchical Storage Management (HSM) feature. Once data has been archived,

the backups will display in the Restore tree as greyed out folders, allowing you to browse the

file/folder structure of the backups.

Backup Selection i#l | Restore - | Logs '__l
AL 1

V ﬁ Eackups

< | Last Backup (26 Jul 2010, 3|
L

.--;I Workspace

P usr
k. Previous Backups
B | 11 Aug 2010, 14:39:07
P | 11 Aug 2010, 14:32:54
P | 11 Aug 2010, 14:32:40
B |0 11 Aug 2010, 14:38:31
B | 11 Aug 2010, 14:38:21
B |0 11 Aug 2010, 14:32:11
B LD 11 Aug 2010, 14:38:02
= 11 Aug 2010, 14:37:51
= I

Workspace

D’ usr

i) Grey folders indicate archived data. However, if you do not see these folders in
the Restore tree, it does not mean that no archived backups are available. In such
cases, pease consult your Backup Administrator for further details about archived
backups.

If you try to restore archived data, you may receive a message informing you that the data has
been archived to secondary storage, as illustrated in the screenshot below.

X

(£ L]

F This data has baen archived to secondary storage
"~:_ ! and rermoved from the Storage Platforrm. To rastore any of thase files,

please cortact vour backup adrinistrator and request
to have the files moved back to the Storage Platform.

s & ok
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You can access archived data by requesting that your Backup Administrator import the HSM
data to the Storage Platform. Once the data has been imported, it will be available for restore in
the same manner as all other backups.
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The Backup Client logs all backup and restore processes and their results in log files thatyou can
view on the Logs tab. The following sections describe how to access log filesand modify their

settings.

Accessing log files

The Logs tab in the Backup Client provides detailed information about each backup and
restore. An additional toolbar button appears when the Logs tab is opened: the Summary
button. Use the button to view only errors and warnings and the last 14 lines in the log file.

File Tools

A OO0 ®O O|=

Restare

Help

Find Options  Automate Help Summary

Backup Selection & Restore | Logs =
31 Jan 2010, 19:00:02 [

31 Jan 2010, 03:04:08
30 Jan 2010, 19:51:24
30 Jan 2010, 19:50:54
30 Jan 2010, 19:03:21
30 Jan 2010, 19:00:02
28 ]an 2010, 01:47:37
28 an 2010, 01:44:24
27 ]an 2010, 21:31:40
26 jan 2010, 19:29:35
26 an 2010, 19:29:22
26 jan 2010, 19:29:08
26 an 2010, 19:25:45
26 Jan 2010, 19:08:51
26 ]an 2010, 19:07:01

Il o W T I i T N Y = |

b

Errors and warnings

Last few lines of log file

Message: 19:00:09 Tech
Message: 19:00:09 Backup prepared in:
Message: 19:00:09 Mew files: 0; 0.0KB |
Message: 19:00:09 Removed files: 0; 0.
Message: 19:00:09 Patched files: 1; 0.8
Message: 19:00:09 Skipped files: O

Message: 19:00:09 Disk usage 48% full
Message: 19:00:09 Cache using 1.6 KB
Message: 19:00:09 Temp dir using 5.52
Message: 15:00:09 e Data |
Message: 19:00:09 Mo Meed to transmit

Ready Last backup:lan 31, 2010 7:00:07 PM
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You can specify your logging preferences on the Logging pagein the Options and Settings
dialog box.

Modifiable settings include :
level of detail included
date inclusion/exclusion in time stamp
log file retention period

For information on configuring the log file settings, see Logging i n Chapter 8, AiOption
settings. o
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To access the Options and Settings dialog box

On the Tools menu, click Options
Alternatively, click the Options button on the toolbar:

°5 D000 e

Backup Size Restore Find Options | Autornate Help

The various options and settings are grouped in the left-hand pane according to their functions.
Click an item on the left to view the full set of options related to that function.

& | Example: Click Advanced Options in the left-hand pane to view all advanced options
on the right:

[E Options and Settings x
) Account and Security -
€ Connactions Advanced Options

) Backup Scheduls

) Backup Throttls

) Display

) Disk Usage J] Always connect to the Storage Platform during the backup process

) Performance and Limits Note Enable this option to alnays update the Storsgs Platform with the last backup date,
" Global Filters even if there wera no changes to the backup selection.

1 Patching

) Mandatary Patching

) Loggin . )
© Advanead Optons 4] Verify account limit before compression/patching

/] Use secure (S5L-enabled) connection for data transfer (Recommended)
Warning: This should only be disabled to enhance transfer speeds after the network has
been confirmed to be secure.

Communications

Complete compressionpatching before sending data to the Storage Platform.

Retries and Timeatts
Number of BackupiRestore attempts before cancelling :I 04
Duration between connection retries (seconds) :I ]

Sacket timeout (saconds) :I 50

cancal] | e

Warning:  The Options and Settings dialog box controls advanced features in the
Backup Client. Please read through this section carefully before changing any settings.
Incorrect setti ngs could cause critical errors.
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Account and Security

You can use the Account and Security page in théptions and Settings  dialog box to:
Update Account information
Change your password, encryption key orBackup Account properties
Modify Client security settings

B © Account and Security [ ) ~
) Connections Account and Security

:: g:zﬁs '?P:r;:flile Account Information

) Display

) Disk Usage Backup Account: ACCOUNT 01
) Parformance and Lirmits Backup Group: A-S5P OWMNER\RESELLER S\BACKUP ACCOUNTS
) Global Filters Storage Platform: 192.168.20.120
) Patching Your current accourt limit is: 5120 ME
) Mandataory P atching

) Logaing § . .

T Advancad Options Click on Retrieve Settings to connect to the Retrieve S ettings

Storage Platform and retrieve the account settings.

Account Setup

From this section, you can change your password or encryption key and run the Setup Wizard,
should wou want to create a new accourt or reconnect to an existing ons.

Change Password | | Change Encryption Key | | Run Setup Wizard

Security Settings

Specify whether the Backup Clent should remember the Backup Account password during the
backup or restore procedures.

#® Remember password for backup and restore
Prompt for password on restore

Prompt for password to open the Backup Client and to restore. (If yvou forget the
passwaord you will have to reinstall the cient)

Cancel Help
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The Account and Security page consists of the following areas:
Account Information
Account Setup
Security Settings

This area displays your Backup Account information as it is configured on the Storage Platform.
You can use theRetrieve Settings  button to update your Account settings.

This button is useful to verify that the Account limit has been modified after
requesting a change from the Backup Administrator or to update Backup Group
Profiling settings.

You can use theChange Password and Change Encryption Key buttons to overwrite the
current password and encryption key. To change your Backup Account settings, click the Run
Setup Wizard button. For more information, see Account Setup Wizard in Chapter 3,
fiAccount setup. O

1, | Warning:

Changing the encryption key involves intensive processing on the Storage
Platform and may take several minutes. You should avoid doing this unless the
encryption key has been compromised.

Disaster recovery is not possible without the encryption key. Please ensure that
this key is kept in a safe place. THIS ENCRYPTION KEY IS NOT STORED ON
THE STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF
LOST.

In the Security Settings area, you can select whether or not the Backup Client should remember
the Backup Account password when running a backup or a restore.

There are three options available:

Remember password for backup and restore : The Backup Client remembers the
Backup Account password when doing a backup or restore. This is the default setting.
Prompt for password on restore : The Backup Client prompts for the Backup
Account password during the restore process.

Prompt for password to open the Backup Client and to resto re: The Backup
Client prompts for the Backup Account password when opening the Backup Client and
the Restore tab.
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Connections

You can use theConnections page in the Options and Settings  dialog box to:
Modify Storage Platform connection settings
Enable/disable/configure proxy server details

E] Options and Settings 1
) Account and 5 ecurity C ti
- € Connections I onnections
) Backup Schedule . ;
) Backup Thrattle Connection Settings
) Display : . . . . .
€ Disk Usage Use this section to change your connection settings. These settings were configured in the Setup
) Parformance and Limits Wizard during the installstion process.
C i - .
Globa! Filters (® Use network connection
) Patching
) Mandataory P atching
) Logging
re

Advanced Options

Proxy Server

If waou use a proxy server for your Internet connection, you will probably have to supply the
same proxy server information in the Backup Clent.

® Mo proxy
Use HTTP proxy

Use SOCKSwS Proxy

Cancel Help
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The Connections pageconsists of the following areas:
Connection Settings
Proxy Server

In this area, you can change the type of connection that the Backup Client uses taconnect to the
Storage Platform. You can choose between a network or dialup connection.

i) The Dial -up Settings button is enabled if you select Use dial -up connection
Click this button to select an existing dial -up connection configured on the computer and
then supply the username and password for that Internet connection.

In this area, you can specify whether or not the Backup Client should connect to a proxy server
when connecting to the Internet. If you select that it sho uld, you can specify the proxy server
details in the relevant boxes.



ATTIX’

Backup S chedule

You can use theBackup Schedulepage in the Options and Settings  dialog box to:
A Enable/disable daily automatic backups
A Create advancedautomatic backup schedules

) Account and 5 ecurity _ -
" Connactions Backup Schedule

- " Backup Schedule l

Mandatary P atching

Logging Back up every day at: —{(19 00 | @

1 Advanced Options

) Backup Throttle .

= Displas Backup Set: |.Default v i X
) Disk Usage ;

) Performance and Lirnits ~Automatic Badps

) Global Filkers . .

) Patching [f] Daily automatic backups

=

~

=

[] Advanced Schedule
Back up at the following tirmes

- Week Day ——— ~ Additional 5chedule

Backup time:

Tz @

H| EE

[ ok ]|Qancel|| Help |
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The Backup Schedulepage consists of theAutomatic Backups area.

i) If using Multiple Backup Sets, u se the Backup Set drop-down at the top of the
dialog box to specify which backup set schedule you wish to configure. For more
information, see Multiple Backup Sets in Chapter 8, fAOpti ons and Se!

In this area, you can enable or disable automatic backups.

Daily automatic backups are enabled by default unless disabled during the
Backup Account setup. If disabled, you can enable it by following the
instructions below.

To enable automatic backups:
1. Select theDaily automatic backups check box.
2. Specify a time in the Backup every day at  box
3. Click Ok.

To disable automatic  backups (nhot recommended)

1. Clear the Daily automatic backups and Advanced Schedule check boxes.
2. Click Ok to close the Options and Settings dialog box

v | Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is
strongly advised .

For detailed instructions on how to enable and schedule automatic backups, seeScheduling
automatic backupsi n Chapter 5, ABackups. 0
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Backup Throttle

The Backup Throttle pagein the Options and Settings  dialog box enables youto specify the
Client's bandwidth usage speed limits. You can do this by creating a backup throttle schedule.
Backed up data will then only be transferred at the specified speed limits during each interval.

El Options and Settings »
) Account and S ecurity ) )
6 Connactions Backup Throttle
" Backup Schedule —
- (" Backup Throttle l [ Eremlms
C D!5P|EY Specify one ar more speed limits (in klobytes per second) that can be used when sending backup
) Disk Usage data to the server. A limit of 0 indicates that no limit will be applied.
) Parformance and Limits
) Global Filkers o — R o —
) Patching . Lirmit 1: | i} | kBis . Limit 2: | i} | kBjs
) Mandataory P atching i i
) Logaing . Lirnit 3: |0 | Bis . Lirnit 4: |0 | keis
) Advanced Options — —
Lirnit 5: |0 | kets . Lirnit &: |0 | kets
— Throttle Map
i E . Selected speed limit:
Irnterval: | &0 | minutes (Click to cycle)
1 2 5 7 =] 11 1= 15 17 13 21 28

Monday

Tuesday

Wednesday

Thursday

Saturday

Sunday

| Clear | | Default |
< 0>

[ Ok ]|Eance||| Help |
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The Backup Throttle page consists of the following areas:
Speed Limits
Throttle Map

In this area, you can specify one or more speed limits (in kilobytes per second) that can be
applied when sending backup data to the server.

To specify a speed limit:
Choose a colour to represent the limit and specify the limitint h at clonitohox. 6 s
You can now schedule the speed limits in the Throttle Map area as described below.

i) A limit of O indicates that no limit will be applied.

In this area, you can indicate when the speed limits specified in the Speed Limits area should
apply by creating a throttle map.

By default, a throttle map is provided with different colours indicating week day
office hours, out-of-office hours and weekends (using intervals of 60 minutes ). You can
either set speed limits for the colours used in this default map or you can click
the Clear button and create a new map by following the instructions below .

To create a throttle map

1. Inthe Interval box, specify the number of minutes that each block in the graph should
represent.

2. Inthe Speed Limits area, click a speed limit colour.

3. Inthe Throttle Map area, click the schedule interval boxes you wish to apply the limit to.
The colour of the selected interval boxeswill change to match that of the chosen limit.
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Display

You can use theDisplay page in the Options and Settings  dialog box to select your Backup
Client display preferences.

1 Account and Security Displ:
Connections el

Backup Schedule ;
B ackup Threttls Selection Table

Display l ) . ) )
Disk Usage [] Display File Type column in selection table.

Performance and Limits
Global Filkers [ Display folders in selection tabls.
P atching
Mandatary P atching
Logging

Advanced Options

alelelelelele]: alelele)

H| EE

[ ok ]|Qancel|| Help |
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The Display page consists of a Selection Thle area that provides you with the following options:

Display File Type column in selection table - Adds aFile Type column to the
right -hand pane of the Backup Selection and Restore tabs.
Display folders in selection table - Enables the Backup Selection tabd sight-

hand paneto display subfolders.
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Disk Usage

You can use theDisk Usagepage in the Options and Settings  dialog box to:
Move the working folders and cacheto a different location
Specify the number of days that files are to be kept in the cache

Account and 5ecurity _ .
Connections Disk Usage

Backup Schedule Working Folders

-
-
re
) Backup Throttle
) Display .
oo fou can move the Cache, Log, Temporary folders and the Selection D atabass to ancther
s B | o e o e ilable on the drive where the Backup Cliert is installed
) Parformance and Limits location if there s imited space availlable on the drive where the Backup Clent 15 installed.
) Global Filters Mote: Always keep these folders on the same drivelvolume.
) Patching
) Mandatory Patching
) Logaing Temp: |fusrfsharefaSbackup,ftoBackup | Erowss...
) Advanced Options
Cache: |jusrjsharejaSbackup,fcache | Browse...
Logs: |fusrfsharefaSbackupflngs | Browse...
D atabase: |fusrfsharefa5backup | Erowss...
Cache

Changed files are compared to the previous version to only transmit patches. The longer files
are kept inthe cache, the better the chance of transmitting patches instead of full copies.

Days to keep files in Cache: ill 20 | Clear Cache...

Cancel Help
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The Disk Usage page consists of the following areas:
Working Folders
Cache

If you have limited space on the drive running the Backup Client, you can move
the Cache, Logs and Temporary folders as well as the selection database¢o another location.

The following locations are configurable in this area:
Temp - Used as temporary workspace when the files are patched, compressed and
encrypted.
Cache - Keeps a local, compressed and encrypted, copy of the selected files for a
specified number of days.
Logs - Stores all backup and restore logs.
Database - Compares the latest backup selection with the previous backup to
determine the changes.
1. | Warning:
The Cache and Temp folders must reside on the same drive/volume.
If the database or any of the folders are stored on a network share, please ensure

that the Backup Service has the correct permissions to connect and write to that
share.

When modifications are made to a file, the Backup Client only transmits changes to that file, as
opposed to transmitting the complete file again. This is accomplished by the use of a local cache.

By default, recently modified files are kept in the Cache for 20 days, after which they will be
deleted. Once a file has been flushed from the cach, a full copy will be backed up when any
modifications are made to the file. The longer files are kept in the Cache, the better the chance of
only transmitting patches instead of full copies and thus reducing the amount of data that needs
to be transmitte d. If there is limited disk space available, consider shortening the time files are
kept in the cache.

i) If you specify 0 days for caching, patching is disabled. All files in the Cache will
be deleted, andfull copies of changed files will be transmitted to the server during each
backup.

To delete the current cache, use theClear Cache button. If the cache is deleted, full copies of
the selected files will be re-sent to the Storage Platform during the next backup.

i) The Backup Client will log the message Doing monthly cache cleanup once a
month. This maintenance task is to ensure that there are no redundant files in the Cache.
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Performance and L imits

You can use thePerformance and Limits page in the Options and Settings dialog box to:
Increase/decrease BackupClient processor usage
Increase/decrease Backup Client disk accessisage
Set data transfer limits
Ensure that a certain amount of free spaceis always available on the hard drive during
data dumps, patching or compression

Account and 5ecurity _ : .
C onnections Performance and Limits

Backup Schedule
Eackup Throttle
Display

Disk Usage

Processor Usage & Disk Access

If wou experience any performance deterioration during the backup process, you can lessen this

palalelel alalalelele]

Frimenr o e | effact by lowering the pracessor usage and disk access of the Backup Clisnt.
Global Filkers
P atching
Mandatary P atching Processor Usage: 4
Logging
Advanced Options | 0 | 0 | .
Low High
Disk Access: 1}
| ! | ! | ! | ! | ! |
Low High
Limits

This section allows you to manipulats the data transfer during the backup process if vou have to
limnit the transfer in ary way.

Restrict size of 2ach backup (ME): :‘

Free Space

Ensure that the Backup Client does not use all available hard drive space during data dumps,
patching or cormmpression.

Enforce fres space (GE): :‘

Cancel Help
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The Performance and Limits page consists of the following areas:
Processor Usage & Disk Access
Limits
Free Space

The Backup Client uses a fair portion of available processor power to patch, compress and
encrypt files during the backup process. If you use the computer at the same time, you may
experience some performance deterioration. To lessen this effect you can lower the Processor
Usage.

1. | Warning:  If you use the highest Processor Usage  setting, it will affect server
performance during the backup.

Disk Accessis another setting that you can modify to limit performance deterioration. If you
use the High setting, the Backup Client will continuously use all available disk access to read
and write to the disk, ensuring that the process completes asquickly as possible. The process
will take longer if this setting is lowered but other disk -intensive applications will perform
better.

Select the Restrict size of each backup (MB) check box and specify a maximum value to
limit the total amount of data that may be transmitted to the Storage Platform during each
backup.

If this option is enabled, it may take several backups before all files are
transmitted to the Storage Platform. This feature is especially useful when using a slow
Internet connection and ther e are problems with transmitting large backups.

Cycle backup process... 1 You can use this setting in conjunction with the backup size
restriction to cycle backups successively until all dataincluded in the backup selection has been
transmitted to the Storage Platform. This setting canis only available if a backup size restriction
has been specified.

To ensure that the Backup Client does not use all available hard drive space during data dumps,
patching or compression, you can select theEnforce free space check box, and then specify
the maximum amount of disk space the Client will be allowed to use.
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Global

Filters

Mandatary P atching
Logging

[[] Exclude these files:

You can use theGlobal Filters page in the Options and Settings  dialog box to:
A Exclude files globally
A Exclude folders globally
A Setup a No Compression Hter
E] Options and Settings 1
) Account and 5 ecurity . = _
) Conmections Global Filters
re
~ SZEEE .?;:z‘:lje — Exclude Files
'r: D?EF"E'Y f'ou can specify file extensions that must be excluded from the selection list at all times. Files can
; Disk Usage o also be excluded according to their modified date.
- (=] ZT‘::ZTE;::: and Limits Mote: Systemn exclusion filters are marked with a different icon in the Backup Client and cannet be
) Patching selected for backup.
~
-~
=

1 Advanced Options

Examples:
file? dac
vidao® *
* mp3

specific. avi

[7] Do not back up filas older than: { dd-rrrm-yywy )

— Exclude Falders

Specify folders that should be excluded fram the backup selection, ne matter where they are
located on the available drives or volumies. Mote: no wild cards or path separators are allowed.

[[] Exclude these folders:
Examples:

My Music
Data
Pheotos

~ Mo Compression Filter

fou can specify file extensions for which no comprassion will be used. This is a global setting.

[f] Donot compress these file types: |* zip;*.cab;*.gz;*.bz2;*.rpm;*jpg;*.rar;*.7z;*.gif,".png -

<l

>

[ ok ]|Qancel|| Help |
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The Global Filters pagein the Options and Settings dialog box consists of the following areas:
Exclude Files
Exclude Folders
No Compression Filter

In this area, you can specify that files with certain file names, extensions or last modified dates
be excludedfrom all backups.

To exclude files based on  their file name s or extension s:
1. Select theExclude these files check box.
2. Type the file name(s) and/or file extension(s) in the box provided; separated by
semicolons or listed beneath each other.

v You can use wildcards. E.g. *.mp3 will exclude all MP3 files from backups.

= To exclude all MP3 and AVI files, specify *.mp3 and *.avi in the text
box. Separate entries with a semicolon or type each on a new line.
3. Click OK.
To exclude files based on their ‘last modified' date s:
1. Select theDo not back up files older than check box.
2. Inthe box provided, type the date in dd-mm-yyyy format.
3. Click OK.

In this area, you can exclude certain folders from all backups.

To exclude folders:
1. Select theExclude these folders  check box.
2. Type the folder names in the box provided; separated by semicolons or listed on
separate lines.
i)

Wildcards and path separators are not supported in this area.
Entries are case sensitive.

3. Click OK.
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In this area, you can specify the file types that the Backup Client should not compress during the
backup process.

v Compression is not effective on all file types as some files may already be
compressed or cannot be compressed at all. The Backup Client could spend some time
and processing usage trying to compress these files. You can use ths filter to specify a
list of file extensions that the Client should not attempt to compress during the backup

process. The list of file types already specified are types that typically do not compress
well.

To exclude files from compression:

1. Select theDo not compress these file types check box.

2. Type the file extensions in the box provided, separated by semicolons.
3. Click OK.
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You can use thePatching page in the Options and Settings  dialog box to:
Enable/disable Delta Blocking
Enable Binary Patching limits
El Options and Settings x
) Account and S ecurity )
) Connections Patchlng
) Backup Schedule -
) Backup Throttle Detta Blacking
) Display _ . . .
) Disk Usage Delta Blocking is faster than Binary Patching and does not need a complete copy of the filz inthe
) Parformance and Limits cache. It will however creats larger patches and therefore use more disk space on the Storags
) Global Filkers Platform.
- - Patching - [] Enable Delta Blacking for:
) Mandataory P atching
) Logaing
=

Advanced Options

Einary P atching Threshald

Some data files can change significantly from ane backup to the next, resulting in large, inefficient
patch files. Setting a patch abort threshold enables vou to abart such a patch and transmit the
complete file to the Storage Platform instead, saving processing time.

[7] Enable patching limits

Abort threshald: | 10| GB

Mote: This option is useful for databases that are re-organized pericdically and cause the backup

window to be excesdead.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The Patching pagein the Options and Settings  dialog box consists of the following areas:
Delta Blocking
Binary Patching Threshold

Delta Blocking is an alternative to Binary Patching and compares changes on a block level. It is
significantly faster than Binary Patching and does not require a complete copy of a file in the
Cache to calculate the patch, only a footprint file. The footprint file requires very little free disk
space - 0,0006% of the original file. However, Delta Blocki ng patches are much larger than
Binary patches.

i) Pleaseread through this section before enabling this option in the Backup Client.

To enable Delta Blocking:

1. Select theEnable Delta Blocking  for check box.

2. The Delta Blocking file selection criteria can be set in two ways: by file size or file type.
Select the applicable condition(s) and supply the necessary information. Any recently
changed files not matching these criteria will be patched using Binary Patching.

1. | Warning:  Some database fies may not be suitable for Delta Blocking since data is
shifted at the beginning of the file. When this happens, it will result in a patch as large
as the complete file. It is advisable to closely monitor the sizes of the patches when Delta
Blocking is enabled and disable it if it turns out to be ineffective.

Binary Patching is the most effective form of patching. It is CPU-intensive but will deliver the
smallest patches. The process is only possible if a complete copgf an older version of the file is
available in the Cache.

i) Binary Patching is enabled by default and nothing needs to be configured on this
tab for normal use.

Enabling patching limits . It is possible that a file could be modified in such a way that it
becomes impractical to patch it. An example would be a database that is reindexed.

In such a case, the patching can take extremely long (it may exceed the backup window) and will
eventually create a patch that is the same size as the complete file. lwould be better to abort
the patching and compress the new file instead. The patching limit indicates when patching will
be aborted and the complete file compressed and resent to the Stoage Platform instead.
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To specify patching limits:

1. Select theEnable patching limits check box.

2. Inthe Abort threshold  box, specify the abort threshold (in gigabytes).

When this limit is reached, patching will be aborted and the complete file will be
compressed and resent to the Storage Platform.

Patching limits should only be enabled if you have severe patching problems
with large files.
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Mandatory Patching

You can use theMandatory Patching page in the Options and Settings

dialog box to instruct

the Backup Client to scancertain files, regardless of whether or not they appear to havwe changed

since the last backup (i.e.eveni f

Tip: This is useful in situations where files are held open by an app lication (internally
the file changed, but the change is not reflected in the last modified date on the file

t he

system or in the size of the file itself).

Advanced Options

f

ebs

ti me)st amp

remai

3] x
) Account and 5 ecurity _ -
) Conmections Mandatory Patching
) Backup Schedule The following files will be scanned for changes regardless of whather
© Backup Throttla they appear to have changed since the last backu
© Display v appear to have changed since the last backup.
) Disk Usage
) Performance and Lirnits Add
) Global Filbers
) Patching
B Mandatory Patching [ Remove
) Logging
re

Cancel Help

ns
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Files selected for mandatory patching display on the Backup Selection tab with a green icon

containi t®e |

ng

To select files for mandatory patching:
1. Click the Add button.

etter
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MyFestores

Festores
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Seript Plugins
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2. In the Open dialog box that appears, navigate to and select the file(s) and then click
Open . The file(s) location(s) will display in the Mandatory Patching list.

3. Click OK to saveyour settings.

.
)

Tip : Select more than one file at a time by holding down the SHIFT key and selecting
the files with your keyboard or mouse.
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Logging

You can use thelLogging page in the Options and Settings  dialog box to specify your logging
preferences.

Modifiable logging settings include:
Level of detail included
Date inclusion/exclusion in time stamp
Application log location and debug inclusion/exclusion
Log file retention period

E] Options and Settings 1
) Account and 5 ecurity L -
) Connections ogging
) Backup Schedule
) Backup Throttle Eackup and Restore Lags
= D!SPI‘E':" f'ou can specify the amount of detail and the content that should appear in the backup and restore
) Disk Usage log files.
) Performance and Lirnits
) Global Filbers Level of Detail: All infarmation ~
) Patching
) Mandatary Patching Include date in log file tirme stamp.
B Logging
[=

Advanced Options o
Application Log

Log file: |backupservice.log Browse...

Log debug messages

Autornatic Log File Delstion

f'ou can specify that old log files be deleted after a certain amount of days.

Delete log files alder than (days): i‘ 30

Cancel Help

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The Logging pagein the Options and Settings dialog box consists of the following areas:
Backup and Restore Logs
Application Log
Automatic Log File Deletion

In this area, you can secify the level of information to be included in the log files by selecting
one of the options provided:

All information (I ogs all message$

Suppress detail

Log warnings and errors (logs only warnings and errors)

Select thelnclude date in log file time stamp check box to add the date to every line in each
log file.

In this area, you can specify where the Backup Client's application log file should be saved and
whether or not debug messages should be logged.

In this area, you can enable a log file retention period by specifying that the Backup Client delete
files older than a particular number of days. To do this, select the Delete log files older
than check box, and then specify the number of days in the box provided.

To delete all logs older than the specified number of days immediately, click the
Delete Older Logs Now  button.
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Advanced Options

You can use theAdvanced Options page in the Options and Settings  dialog box to configure
the following Backup Client options:

Storage Platform communication

Retries and timeouts

’SZTHUE";E:: Securty Advanced Options

-
=
) Backup Schedule —
" Backup Throttle Communications
) Display i
) Disk Usage | Always connect to the Storage Platform during the backup process.
™ Perforrance and Lirnmits Meote: Enable this option to always update the Storage Platform with the last backup date,
) Global Eilters even if there were no changes ta the backup selection.
) Patching . . .
) Mandatory Patching Complete compressionipatching before sending data to the Storage Platforrm.
) Logging . . ) )
[ 7 Advanced Options | ] Werify account limit before compression/patching.

| Use secure (S5L-enabled) connection for data transfer [Recommended).
‘Warning: This should anly be disabled to enhance transfer speeds after the network has
been confirmed to be secure.

Retries and Timeouts
Murnber of BackupiRestore attempts before cancelling: i‘ a4
Duration between connection retries (seconds): i‘ &0

Sockst timeout (seconds): i‘ &0

Cancel Help

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The Advanced Options pagein the Options and Settings  dialog box consists of the following
areas:

Communications

Retries and Timeouts

Always connect to the Storage Platform during the backup process

When the Always connect to the Storage Platform ... check box is selected, the Backup
Client will connect to the Storage Platform during each backup, whether or not changes were
made. This updates the Last Backup date stamp, even if there were no changes made to the
backup set, ensuring that the Storage Platform always reflects the latest backup date.

Complete compression/patching before sending data to the Storage Platform

Select this option if you do not wish to make use of the concurrent backup processing feature to

speed up the backup process. (Concurrent backup processing is typically needed when using a

dial-up Internet connection.For mor e i nf or mat iac k ispe ep riicCooenscsuirmrgein tl a
this chapter.) With this setting enabled, the Backup Client will compress all new files and patch

all modified files before starting to transmit data to the Storage Platform.

Verify account limit before compression/patching

With this setting enabled, the Backup Client verifies the Backup Account limit on the Storage
Platform before starting compression and/or patching. This is useful as it will flag Account limit
issues before starting these possibly time consuming processes.

Use secure (SSL -enabled) connection for data transfer...

This option is selected by default, enabling SSL encryption for Client-to-StorageServer data
transfers. Deselecting this option disables SSL encryption for data transfer. This enhances
transfer speeds but should only be done within a secure network environment.

Disabling this feature will only have an effect on security for the actual data
transfer and not the encryption of the data on the Storage Platform

Secure data transfer connections can only be disabled if the StorageServer has
been configured to accept non-secure connections. If the StorageServer cannot
accept non-secure connections, an SSkenabled connection will automatically
be used instead.

/v | Warning @ If you wish to disable SSL encryption, please ensure that the backup
environment is secure.



ATTIX’

Number of Backup/Restore attempts before cancelling

By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. You are advisedto increase the number of attempts when using a
slow Internet connection. The backup will continue from the previous point of failure and not
resend the entire backup.

Duration between ¢ onnec tion retries

By default, if the connection is dropped, the Backup Client will try to reconnect to the Storage
Platform after 60 seconds. This setting enablesyou to increase/decrease the duration between
the retries.

Socket timeout

If the Backup Client is connected to the Storage Platform and there is no communication
between the two, the time specified in this box (in seconds) is how long the Backup Client will
stay connected before dropping the connection. The default socket timeout is 60 seconds.
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SE includes tools that allow advanced users to modify, enhance and streamline the Backup
Client.

SE supports concurrent backup processing. Files will be transmitted to the Storage Platform
using a second thread as soon as the files are compressed or patched while the backup process
continues to compress/patch files using the original thread in the background.

This method of backup processing is the default method and will improve the total backup speed
significantly. If, however, you wish to disable this method, you can deselect the Complete
compression/patching before sending data to the Storage platform check box on the
Advanced Options page in the Options and Set tings dialog box. For more information, see
AfAdvanced Optionso earlier in this chapter.
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Remote Management enables the Backup Administrator to remotely access and configure the
Backup Client using the Storage Platform Console.

To enable Remote Management:

1. Onthe Tools menu, click Remote Management

2. In the Remote Management Settings dialog box that appears, select the Enable
Remote Management  check box.

3. In the Connection area, ensure that the port number in the Port box is correct (9091 is
specified by default). If incorrect, modify as required.

4. If the server has multiple IP addresses available, you can specify whether the Remote
Service must bind to all available IP addresses or to only one IP adiress.

5. Inthe Access area,select the access credentials to be allowed.

D

' Allow SP controlled access enables Backup Administrators with the
correct access permissions to use their Storage Platform User Access
Management usernames and passwords to connect to and administer
this Backup Client. If you clear this check box, Storage Platform
administrators wi Il not have remote access.
SelectAllow custom access  and supply a username and password if
you do not wish to make use of the above-mentioned Storage Platform
Access Accounts. These custom access credentials must be specified i
the Storage Platform Console for its user to gain remote access.

6. Click OK to save the settings. Services will restartautomatically to apply the settings.



ATTIX’

When a backup is initiated, the backup selection i :
s e t &et of mcluded files and folders. You can restore the entire backup set (all its files and

folders structured as they were at the time of backup), or restore individual files and/or folders

within it .

The first backup selection you makei n t he SE Client is automatically
b a ¢ k u p Fosnaote information, see Selecting datato back upi n Chapter You ABackups
may, however, create more than one backup set. This enables you to back up different data

selections at different times.

= A full backup of all data on a server can be scheduled to run once a week (e.qg.
over the weekend, when there are no resource limitations) and another backup of only
the SQL database on that same server can be scheduled to run every day. This ensures
that the SQL database is backed up regularly, using minimal resources, and that the
entire server is still backed up but at more convenient and practical time intervals.

i A maximum of 10 backup sets are allowed (including the default backup set).

To create a new backup set:

1. Onthe Tools menu, point to Additional Backup Sets and then click Add .
Alternatively, click the Add button oA above the Backup Selection /Restore /

Logs tabs.

i) The Add button will only be available above the Client tabs when at least
two backup sets exist. If this is your first addition , you need to use the Tools
menu.

2. Inthe Backup set name box, type a display name for the set, and then clickOK .
3. Ensure that the new name is selected in theBackup Set drop-down box.
4. Configure the scheduleas desired.For detailed instructions on how to schedule
backups, seeScheduling automatic backupsi n Chapter 5, HABackups. o

i) If backup set schedules overlap due to manual schedule configuration or

| overlapping backup windows, the backups will be placed in a queue. Three
seconds after the first backup in the queue is complete, the next will run. Backup
sets are queued alphanumerically. If, however, two or more backups are
scheduled for the same backup set and their backup windows overlap, the first
backup will run to completion and duplicates will be excluded from the queue.

5. Click OK. The Options and Settings  dialog box will close and the SE Client will
display the new backup set name in aBackup Set drop-down box above theBackup
Selection tab.
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6.

i) The Backup Set drop-down and Add and Schedule buttons only
display in the SE Client if more than one backup set is enabled. If only the default
backup set exists, these items will not display.

The Backup Selection , Restore and Logs tabs now display information relevant to
the new backup set and they can be used to configure, restore from and monitorit

accordingly.
Select the data to be backed upn this backup set.

Included data will be backed upat the times specifiedin the b a ¢ k u pbackug schexlule and
can be restored usingthe Restore tab.

To rename a backup set:

1.

a bk wn

Click the Manage button (% above theBackup Selection /Restore /Logs tabs.
Select the backup set name in theBackup Set drop-down list.
Click the Rename button = .
Type the new name in the Backup set name  box.

Click Ok.

To modify a backup set's backup schedule:

1.

2.
3.
4

Click the Manage button % above theBackup Selection /Restore /Logs tabs.
Select the backup set name in theBackup Set drop-down list.

Configure the schedule. (SeeScheduling automatic backups in Chapter5,i Bac k up s .

Click Ok.

To delete a backup set:

1.

o wn

Click the Manage button % above theBackup Selection /Restore /Logs tabs.
Select the backup set name in theBackup Set drop-down list.

Click the Delete button #6.

In the Confirmation dialog box that appears, click Yes.

Click Ok .

The Script plug-in only functions on the default backup set.
The Email Notification plug -in always functions across all backup sets .

0)
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The Backup Client Health Check provides information to highlight possible issues before backup
(e.g. free disk space or file/folder access problems) It can also provide the estimated line speed

to the Storage Platform.

&  HealthCheck __[§

The Health Check provides information to pre-smptively highlight possible issues, for example
free disk space problermns and service access rights to files and folders. It can also provide the
estimated line speed to the Storage Platform.

Options
[«] Mernory
Mernory utilisation statistics frarm the last backup as well as overall rmarmory usags to date.

«| Data Protected

Infarmation includes the nurmber of filas and directories selacted for backup.

| Disk Usage

Free space availability for all lacal drives.

«] Line Speed
Line Speed estirmate to the Storage Platform by transmitting data for 10 seconds.

Show Last Health Check Start Close

The following options are available:

Memory - Memory utilisation statistics from the last backup as well as overall memory

usage to date.

Data Protected - Information includes the number of files and directories included in

the backup selection.
Disk Usage - Free space availability for all local drives.

Line Speed - Line Speed estimate to the Storage Platform (determined by transmitting

data for 10 seconds).

You can specify which checks to run by selecting or clearing the relevant check boxes in the
Options area. Click the Show Last Health Check button to see the last report. You

can Print and/or Export the Health Check reports.
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To run a health check:

1. Onthe Tools menu, click Health Check

2. In the dialog box that appears, specify which checks to run by selecting or clearing the
check boxes next to theoptions. Four checks are available (see above).

3. Click the Start button to begin the health check process. TheHealth Check dialog box
appears, displaying the progress of the health check until completion.

7  HealthCheck [§

Completed

Mandatory files: O by
0 bytes

Checking disk usage

Usage will be checked for -

Cache directary: fusr/sharefaSbackup/fcache

Database directory: fusrfsharefaSbackup

Logs directory: fusr/share/faSbackup/logs

Temp directory: fusr/share/aSbackup/ftoBackup

Disk usage for [/

Total space: 7.70 GB

Free space: 4.02 GB

Checking line speed

Test will be for 10s - please wait

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.120:443
Server name: Storage Platform, Attixs

Logging in to file server

Connecting to Storage Platform on 192.168.20.120:8443
Server name: Storage Platform, Attixs

User authenticated

Block size sent: 2,048 bytes

Bytes sent: 57.77 ME

Total time: 10172ms

Connection speed estimate; 5,77 ME/s

Health check complete w

4. When the message: fAHealth doKeck completedo displ a



ATTIX’

The Health Checkresults display in a new dialog box with options to print , export to HTML and
export to CSV.

s = HealthCheckResults  [q
Examine the health check results below and print or export the report as needad.
]
Health Check Results
Healthcheck start time: SuUn Jan 31 20:25:41 5A5T 2010
Healthcheck end time: Sun Jan 31 20:25:53 S45T 2010
Healthcheck duration: 125
Memory
Memory stats last backup
Lowest free: 3.73 MB
Higheast total memaorny 37.BE MB
Maximum memaorny setting: 254 .06 MB
Memory stats to date
Lowest ever free memaorny, 972 3 KB
Highest ever total memaony. 38.09 MB
Highest evar maximum memaory setting: 254 .06 MB
Data Protected
Mandatory files count: 0] -
Prirt Export to HTML Export to CSWV Closa
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The Backup Snapshot feature enables you to create a backup of all items included in your
backup selection and send it to a disk drive. This Snapshot data can then be moved to the
Storage Platform.

You can use this feature to reduce the initial backup window if there is a large amount of data to
be transferred, typically over a slow Internet/network connection. A similar procedure enables
you to restore a large amount of data (e.g. during a disaster recovery).

1, | Warning s:

A This procedure should only be performed with the assistance of the Backup
Administrator.

A Ensure that you have an active Backup Account.

A Before beginning the Backup Snapshot process, it is best to perform a test
backup, transferring only a small amount of data, to ensure that the
StorageServer connection is successful.

To export a Backup Snapshot:
1. Onthe Tools menu, pointto Snapshot , and then click Export Backup Snapshot
SelectThe next backup must be a Snapshot backup
Specify a destination in the box provided.
Click OK.
Initiate a backup.

a b wn

The Snapshot data is now stored in the location specified in step 3 aboveand can be movedto
the Storage Platform. The Backup Administrator can then import the snapshot data to the
StorageServer using the Storage Platform Console(For more information, please refer to the
Storage Platform Console User Manual.)

i) The Backup Account will be disabled at this point to ensure that the Snaps hot
data is the most recent. Once the data has been successfully imported to the Storage
Platform, the Account will be enabled automatically and backups can proceed as usual.
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The Restore Snapshot feature enables gu to restore large amounts of data from a locally
connected device to a machine via the Backup Client.

i) Before you can perform the steps outlined below, the snapshot data needs to be
exported from the StorageServer to a mobile storage device by a Backup Administrator.
For more information, please refer to the Storage Platform Console User Manual.

To restore data from a Snapshot:
1. Connect the mobile storage device containing the snapshot data to the Client machine
or to a Local Area Network so thatit has access to the Client machine.
2. Onthe Tools menu, point to Snapshot , and then click Import Restore Snapshot
3. Select whether you wish to restore the data from a disk drive or recovery server.
a. If restoring from disk, select the Show Restore Snapshot(s ) in Restore

panel check box and then specify the path to the data in theSnapshot
location box.

1. | Warning: The default  snapshot location specified is:

\ Backups\ Import \ Snapshot-Restore. If you wish to use this location, you

need to create the folder structure on the machine and then paste the

shapshot data onto the Snapshot -Restore folder. This folder is not
created automatically. Alternatively, you can use the Browse button to
browse to the location in which you have saved the snapshot data.

i) You need tospecifyt he snapshot dat ads ¢
snapshot folder itself. (E.g. If your snapshot data folder is called
20100506124347 and Yy ou 6 v e CcBapkupms\dmpaortt\ Snapshot-
Restore, you need to specify \ Backups \Import \Snapshot -Restore in
the Snapshot location box, NOT \Backups \Import \Snapshot -
Restore 20100506124347 .)

b. If restoring from a recovery server, select theDo restores from recovery
server check box and then specify the server address and port number in the
boxes provided. If using a proxy server, select theUse proxy settings for
recovery check box.

i) This option can only be used if the Backup Administrator has
prepared a recovery server.
4. Click OK.

The Snapshot data will display as an entry in the Restore tree, enabling you to browse a
directory of its contents and restore files and folders. For more information, see Chapter 6,
fRestores. o
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You can use thecommand-line interface (CLI) to run the SE Setup Wizard remotely, enable SE
Remote Management and to send a wide range of backup and restore commands to any SE
Backup Client connected to a LAN.

The CLI.bat file is included with each SE installation file. Using this file, you can connect to any
SE Backup Client in your organisation, should you prefer to manage Clients from a central
location.

1, | Warning:  The SE Backup Client is required and must be installed on the computer
using the CLl.bat file before the following commands can be used.

To configure a Backup Account or Remote Management settings

Run a5backup - cli - configure {account|remote}

Usage:

abbackup - cli {restore|dates|status|backup|cancel}
[ - rd restoredateidx] [ -rp restorepath | - original]
[ - fd filterdate] [ - fp filterpath] [ - fext filterext]
[ - backupset backupsetguid] [ - compression on|off] [ - overwrite]
[ - nopermissions] [ - noemptyfolders]

" - Ip <restorepath> must be an absolute path and the service must have

full write access to the directory.

When restoring, the default policy is to skip existing files. Specify - overwrite
to overwrite existing files.

Specify i nopermissions  to not restore file and folder permissions.

Specify i noemptyfolders  to not restore file empty folders (useful with T fext).

To start a backup of the default backup set:

abbackup - cli backup

To start a backup of a specific backup set:

abbackup - cli backup - backupset acObe91b - 08b2- 461d -
97618c529f46

To view the status of a task currently being performed by the backup service:
abbackup - cli status

To start a restore from the last backup made, extracting files to the default
restore temporary directory:

abbackup - cli restore

To view a list of available backup dates to restore from:

abbackup - cli dates
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To restore from a different date index obtained with the dates command:
abbackup - cli restore -rd 2

To restore all .XLS files starting with the path C:\ Documents and Settings and
newer than 1 April 2002:

abbackup -cli restore -fd  04/01/2002 -fext .XLS -fp
"C: \ Documents and Settings"

To cancela task:

abbackup - cli cancel
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Profiling enables your Backup Administrator to propagate certain client-side settings from the
Storage Platform to your Backup Client.

It can be used to enforce the following settings:
Backup schedules
Inclusions and exclusions
Filters
Most options and settings accessible via theTools menu

i) Profiled settings take priority over settings specified in the Backup Client.

| When the Backup Client connects to the Storage Platform, it receives a list of all profiled
settings. These changes are implemented in the Backup Client. You can, however,
connect to the Storage Hatform and update profiled settings manually.

To update profiled settings manually :

1. Onthe Tools menu, click Options .
2. On the Account and Security  page of the Options and Settings  dialog box, click
the Retrieve Settings  button.

The Backup Client will retrieve any profiled settings from the Storage Platform and update its
options and settings accordingly.

i) Profiled settings are greyed out, and cannot be modified from within the Backup
Client.

Inclusions /exclusions applied by profiling are displayed with yellow icons in the Backup Client:

File icons:
Included file

¥ File included by filter
Excluded file

Folder icons:
Included folder
¥ Folder included by filter
5 Excluded folder
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Attixs Pro Server Edition provides solutions for numerous databases and applications in the
form of plug-ins to the Backup Client.

This User Manual includes instructions for the Email N otification plug-in, asit is distributed
with the SE Backup Client. Please refer to the Attix5 Pro Server Edition Plug-ins User Manual
for detailed information on the other available plug-ins and settings.

Attix5 Pro  Plug -ins available by default

Email Notification
Script
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The Email Natification plug -in enablesyou to receive email notification on backup activity. You

can configure the plug-in to send emails to specified email addressesnotifying the recipients of
the status of backups.

i)

This plug-in has been induded in SE installers since v4.2. If it is not installed,
run the Plug-in Installer and select the Email Notification plug-in.

The Plug-in installer will run automatically during the SE Client installation if
located in the same folder as the Client RPM.

(5] Email Notification settings X

[+] Use email netification
Metify me when a backup fails
Backup Failed
Metify rme after a successful backup
Backup Completed

Append the subject line with the fallowing options and message

M all settings
Ta: admin@yourdomain.com
From: backup@yourdomain.com

SMTP server: | smtpyourdomain.com

My SMTP server requires authentication

Test

Attach log fil2

Attachrment settings

ok Cancel




To configure the  Email Notification plug -in:

1. Onthe Tools menu, point to Plug -ins, and then click Email Notification
2. Select theUse email notification check boxto enable the plug-in.
3. Selectthe types of natifications to be emailed. The following options are available:
Notify me when a backup fails
Notify me after a successful backup
Append the subject line with the following options and message:
Warnings
Errors

You can modify the Email subjects and content by clicking in the
Messages Subject and Warnings/Errors boxes and then editing the
text.

The Backup Account name is automatically included in the subject, e.g.
fBackup Completed [Backup Account name]a

ATTIX’

4. In the Mail Settings area, type recipient and sender email addresses inthe To and
From boxes respectively and supply the SMTP server address and authentication

information if necessary

i’
=

In the SMTP Server box, you can specify the SMTP Server name in

isolation (e.g. mail.attix5.com) or you can include the port number
(e.g. mail.attix5.com:80).
When no port is specified, 25 will be used by default.

Click the Test button to verify that the settings are correct. A test email will be sent to
the address specified in theTo box and a message will appear confirming if the email
was sent successfully. Click OK to close the message and return to the Email

Notification settings dialog box.
6. SelecttheAttach lo g file check box to include a log file as an attachment.
7. Inthe Attachment settings area, select one of the following options:
Summary, warnings and errors
Entire log file (as per Advanced Options log level setting)

8. Click Ok to save the settings and close theEmail Notification settings dialog box.

The Email Notification plug-in is now activated and configured and will start emailing reports

during the next backup.



10. Reference

Keyboard shortcuts and hotkeys

E5 Refresh active window

SPACEBAR x2 Exclude selected file/folder

SHIFT+ g /C Select multiple files
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